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All Sunburst material is copyrighted.  However, Sunburst does give the purchaser the fol-
lowing permissions:

• You have permission to reproduce any student worksheets in this guide for your
classroom use. You should not, however, copy the whole guide.

• If you purchased this program for one computer, you may use it on a single com-
puter.

• If you wish to use this software on multiple computers, you must purchase the
right to do so from Sunburst. Call and ask for lab pack/site licensing prices.

• You have permission to use lab packs/site licenses within one site. You do not,
however, have permission to divide the package and use the software in more
than one site.

Customer Service
1-800-321-7511
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started

1

introduction
Experience the enchanted and fragile ecosystems of tropical rainforests in South America,
Africa, and Southeast Asia. Discover the intricate relationships among the plants, ani-
mals, and people living in them. Learn the status of these rapidly shrinking forests and
what individuals can do to help preserve them.

A Field Trip to the Rainforest Deluxe includes a Discovery area to investigate rainforest
habitat, a sortable database; a terms dictionary to learn definitions of unfamiliar words; a
word processor for taking notes and importing pictures; a challenging trivia game; and a
Field Guide full of pictures and fascinating facts about rainforest flora and fauna.

disclaimer
It is important to note that although every effort has been made to provide current, accurate
data in this program, the status of the world’s remaining tropical rainforests—and the
species living in them—is changing constantly. In 1997, political unrest, poverty, and over-
population are at the core of much deforestation. Experts hold a grim view of the rainforests’
future unless there are significant environmental, political, economic, and social reforms.

Since the flora in each tropical rainforest varies, it is impossible to give an exact height of
each of the layers of vegetation in the forest. In some rainforests, the canopy only reaches
80 feet high, while in other rainforests the canopy encompasses trees 150 feet high. Some
resources describe only three layers of vegetation, although most identify four. A Field Trip
to the Rainforest Deluxe chooses to identify four layers and measure them in accordance
with the most often cited measurements: emergent layer: 150-250 feet high; canopy layer:
60-150 feet high; understory: 12-60 feet high; and the forest floor: all foliage that grows
on the floor, up to about 12 feet off the ground.

system requirements
Windows: A computer with 1 MB of free hard drive space (20 MB for Standard installa-
tion) and a 486/66 MHz or higher processor running Windows 3.1 or higher with 8 MB
of RAM. Also required are a 4X CD-ROM drive, a sound card, and a color monitor set to
run in 256 colors.

Macintosh: A 68040 processor or better, 25 MHz, System 7.0 or higher, 8 MB of RAM, a
640x480 monitor capable of 256 colors, and a 4X CD-ROM drive or faster.

installation
Windows: Start Windows and insert the CD into your CD-ROM drive. Select Run from the
menu. In the Run dialog box, type D:\setup.exe and click OK. Follow the on-screen instruc-
tions to complete installation. For best performance, Standard installation is recommended.

Macintosh: Place the CD in your CD-ROM drive and double-click the Rainforest Deluxe
icon. Double-click the Rainforest Deluxe installer. From the install dialog, follow the on-
screen instructions to complete installation. For best performance, Standard installation is
recommended.

running the program
Insert the CD into your CD-ROM drive and double-click the A Field Trip to the Rainforest
Deluxe icon in the Sunburst Program Group (Windows), or open the Rainforest Deluxe folder
on your hard drive and double-click the Rainforest program icon (Macintosh).
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Welcome to A Field Trip to the Rainforest Deluxe. You’ll begin your journey into the
rainforests at the Visitor’s Center main menu (shown below). There, you’ll be met

by host Iguana Jack, the friendly chap wearing the pith helmet. Listen while he describes
the program’s features, or jump right in and investigate on your own.

Hot Buttons
To hear a brief summary of the program’s highlights, click on tour guide Iguana
Jack.

To go to the Discovery Screens to begin a journey into the rainforests of South
America, Africa, or Southeast Asia, click the globe. 

To go to the Field Guide—full of information and pictures of rainforest flora and
fauna—click the book titled Field Guide.

To go to the interactive and sortable Data Table, click the Data Table paper
lying on the table.

To hear words pronounced and to learn the definitions of unfamiliar words,
click the Terms Book on the bookshelf.

After learning about tropical rainforests, click the Fun Facts Game to test your
knowledge of rainforest trivia.

Help is available at any time by clicking the picture of Tocarra the Toucan.

To return to the Visitor’s Center main menu from any other part of the program,
click the picture of Iguana Jack’s pith helmet.
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To take notes and use the word processor, click the Journal pad and pencil.

Borrow Iguana Jack’s camera by clicking it to take a snapshot of any plant or animal on the screen. 

To exit the program, click on the door to the Visitor’s Center.

All of the pictures on the Visitor’s Center main menu also appear as buttons on the bottom of each screen to
help you navigate throughout the program. 

Menu Bar
The menu bar at the top of the screen provides pull-down menus which you can use to navigate around the
program, instead of or in addition to using the hot buttons on the screen.

• File—Select Exit to quit the program.

• Options:
Select Sound to increase or decrease the sound on the program.
Select Taskbar to hide the taskbar in Windows 95.

• GoTo:
Select Data Tables to investigate the Animal and Plant Data Tables.
Select Discovery to explore the tropical rainforests.
Select Field Guide to explore the Field Guide. 
Select Fun Facts to go to the Fun Facts Game.
Select Terms Book to go to the Terms Book. 
Select Visitor’s Center to go directly to the main menu screen.

• Help—Select About A Fieldtrip to the Rainforest–Deluxe to read the program credits.

3
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discovery screens
When you click the globe from any screen, you will arrive at the Discovery Screen selection window (below) where
you can begin your journey into each tropical rainforest region. Select one of three rainforest regions (Southeast
Asia, Africa, or South America) by clicking the name of the region, located to the left of the spinning globe.

Day/Night
It is always daytime when you enter the forest, so you will see only those (diurnal) creatures that are most
active during the day. Click the day/night icon to change the screen to nighttime so you can see (noctur-
nal) creatures that are most active at night. 

Daytime Nighttime

View Layers of the Rainforest
• Climb from the floor of the forest up through the understory and canopy to the emergent layer and back down

again by using the arrows on the right side of the screen to scroll the picture of the rainforest up or down. 
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A Field Trip to the Rainforest Deluxe

Take A Closer Look
• Drag the mouse over animals and plants on the screen to see their names in the upper right hand corner

of the screen. 

• Click once on any animal or plant to zoom in for a magnified, close-up view. Clicking again on the larger
image zooms back out to the previous screen. 

• To learn about a specific animal or plant, click once on the animal or plant to zoom in and then click the
FIELD GUIDE button on the bottom of the screen. To leave the Field Guide and return to the rainforest,
click the globe. (See Field Guide for more information.)

• To see information about a specific animal or plant in the Data Table, click once on the animal or plant
to zoom in. Then click the DATA TABLE button on the bottom of the screen. To leave the Data Table and
return to the rainforest click the globe. (See Data Table for more information.)

• To take a picture of any animal or plant, click Iguana Jack’s camera on the bottom of the screen. Your cur-
sor will turn into a crosshair . Click and drag the crosshair over the image you want to take a picture
of. (See Camera for more information.)

• To take notes and use the word processor, click the JOURNAL button at the bottom of the screen.
(See Journal for more information).

Southeast Asia
The Southeast Asia Discovery Screen explores the flora and fauna of Southeast Asia’s remaining tropical rain-
forests, including those found in Indonesia, Malaysia, and the Philippines.
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Africa
The Africa Discovery Screen explores the flora and fauna of Africa’s remaining rainforests, including those
found in Zaire and the island of Madagascar.

South America
The South America Discovery Screen explores the flora and fauna of Central and South America’s remaining
rainforests, including those found in Brazil, Colombia, Costa Rica, and Guyana.
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field guide
The Field Guide contains hundreds of facts and pictures of rainforest flora and fauna, as well as information
about people who live and work in the tropics, the resources rainforests provide, the status of the world’s rain-
forests, and what people can do to help preserve them.

To open the Field Guide, click the FIELD GUIDE book button on any screen or select Field Guide from the GoTo menu. 

Table of Contents
To open the Field Guide Table of Contents, click the Field Guide book on any screen. If you are already in the
Field Guide, reading a specific section, click on the red Contents tab on the top right side of the Field Guide.

The Field Guide Table of Contents is divided into seven sections:

1. Introduction—learn about what a tropical rainforest is, where they are located around the world, and what
makes them so different from any other ecosystem on Earth.

2. Animals of the Rainforest—learn about 112 tropical rainforest animals, reptiles, amphibians, insects, and birds.

3. Plants of the Rainforest—learn about 52 tropical rainforest trees, shrubs, epiphytes, ferns, rhizomes, lichens,
vines, lianas, fungi, flowers, and herbs.

4. People of the Rainforest—learn about indigenous tribes, rubber tappers, scientists, and environmentalists
who all live and work in rainforests. 

5. Future of the Rainforest—learn about the reasons rainforests are being destroyed so rapidly and the effects
of the destruction.

6. Rainforest Resources—learn about the foods, medicines, oils, resins, fibers, and building materials that
come from rainforests. 

7. What You Can Do—learn how to help preserve tropical rainforests.

Click on a section title to go directly to that portion of the Field Guide.

using
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Pages
You can read each Field Guide page by using the scroll bar on the right side of the Field Guide notebook.

• To hear the text read aloud, click the AUDIO button . To stop the text from being read aloud, click the
AUDIO button again.

• To learn the definition of any word that is highlighted in dark black text, click on it. The QuickTerms
window will automatically pop up over the Field Guide. (See Terms Book.) To return to the Field Guide,
click DONE. If you select More to read additional information in the Terms Book, click the FIELD GUIDE

button on the bottom of the screen to return to the section of the Field Guide you were reading.

• Each plant and animal in the Field Guide is linked to a Discovery Screen. To see a specific animal or
plant in its rainforest habitat, click the GLOBE button at the bottom of the screen. To return to the Field
Guide page you were reading, click the FIELD GUIDE button. 

• Each plant and animal in the Field Guide is linked to the Data Table. To find the plant or animal in the
Data Tables, click the DATA TABLE button at the bottom of the screen. To return to the Field Guide page
you were reading, click the FIELD GUIDE button. 

• To print any text you see in the Field Guide, click the Print stamp at the bottom of the screen. A
Print Preview screen (see below) will pop up for you to make appropriate printing selections. See page 25
for more information on the Print Preview screen.
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• To take notes while using the Field Guide, click the JOURNAL button at the bottom of the screen. The
Note Taker will pop up over the Field Guide. (See Journal for more information.)

• To take a picture of any animal or plant, click Iguana Jack’s camera on the bottom of the screen. Your cur-
sor will turn into a crosshair . Click and drag the crosshair over the image you want to take a picture
of. (See Camera for more information.)

Tabs
Each Field Guide page has tabs that automatically take you to the sections you wish to read about.

Introduction Tabs
Scroll through the text using the scroll bar on the right side of the screen, and select individual tabs to go to
the section you wish to read about.

• Click the Contents tab to go to the main Field Guide Table of Contents.

• Click the Characteristics tab to learn about such things as the layers of a rainforest, tropical climates,
plant and animal adaptations, and what makes these ecosystems so unique. 

• Click the Locations tab to learn about the different types of tropical rainforests and where they
are located.
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Animals of the Rainforest Tabs
Select a rainforest animal by scrolling through the Animals of the Rainforest index. Double-click on any name
to bring up its Field Guide page. 

Click each tab to learn specific information about each animal, reptile, amphibian, insect, or bird.

• Click the Contents tab to go to the Animals of the Rainforest index.

• Click the Diet tab to learn what the rainforest organism eats.

• Click the Enemies tab to learn about natural predators.

• Click the Attributes tab to learn about physical characteristics.

• Click the Facts tab to learn interesting facts about the organism.

• Click the Photos tab to see a photograph. (If there are no photos available, the tab will be gray.)
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Plants of the Rainforest Tabs
Select a rainforest plant by scrolling through the Plants of the Rainforest Contents page. Double click on any
name to bring up its Field Guide page. 

Click each tab to learn specific information about each tree, shrub, epiphyte, fern, rhizome, lichen, vine, liana,
fungus, flower, or herb.

• Click the Contents tab to go to the Plants of the Rainforest index.

• Click the Characteristics tab to learn about the plant’s physical characteristics.

• Click the Relationships tab to learn how the plant interacts with other plants and animals in the rainfor-
est ecosystem.

• Click the More Info tab to learn interesting facts about such things as a plant’s medicinal properties and
how it is used in cultures all over the world. 

11
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People of the Rainforest Tabs
Scroll through the text by using the scroll bar on the right side of the screen and select individual tabs to go to
the section you wish to read. 

Click each tab to learn about people who live and work in rainforests.

• Click the Contents tab to go to the main Field Guide Table of Contents.

• Click the Tribes tab to learn about indigenous groups who live in tropical rainforests.

• Click the Tappers tab to learn about rainforest rubber tappers.

• Click the Scientists tab to learn about the scientists and environmentalists who live and work among
indigenous people.
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A Field Trip to the Rainforest Deluxe

Future of the Rainforest Tabs
Scroll through the text by using the scroll bar on the right side of the screen and select individual tabs to go to
the section you wish to read. 

Click each tab to learn about the status of rainforests. 

• Click the Contents tab to go to the main Field Guide Table of Contents.

• Click the Reasons tab to learn why rainforests are destroyed.

• Click the Effects tab to learn the global effects of rainforest destruction.

• Click the Rate tab to learn the rates of rainforest destruction and scientists’ predictions for the future of
the forests. 
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Rainforest Resources Tabs
Scroll through the text by using the scroll bar on the right side of the screen and select individual tabs to go
directly to specific portions of the text. 

Click each tab to learn about the many things that come from the rainforest. 

• Click the Contents tab to go to the main Field Guide Table of Contents.

• Click the Foods tab to learn about common foods harvested in rainforests.

• Click the Materials tab to learn about fibers, gums, waxes, dyes, and building materials that are made from
plants harvested in rainforests.

• Click the Medicines tab to learn about medicines that are made from tropical rainforest plants. 
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What You Can Do Tabs
Scroll through the text by using the scroll bar on the right side of the screen and select individual tabs to go to
the section you wish to read. 

Click each tab to learn how you can preserve the rainforests. 

• Click the Contents tab to go to the main Field Guide Table of Contents.

• Click the Educate tab to learn ways to educate others about rainforests.

• Click the Recycle tab to learn how recycling benefits rainforests.

• Click the Wise Buys tab to learn how our shopping habits can help or harm tropical rainforests.

• Click the What Else? tab to learn more ways to help preserve tropical rainforests. 
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terms book
The Terms Book is a glossary of words that appear in the program. You can bring up the Terms Book at any
time by clicking the Terms Book at the bottom of any screen or by selecting Terms Book from the GoTo option
in the menu bar. 

• Use the right and left arrows at the bottom of the page to turn pages of the Terms Book.

• Click the appropriate letter tabs to go directly to any specific word and definition or just type the first let-
ter of the word you want to look up. (The Terms Book automatically goes to the section that begins with
the letter you typed on the keyboard.) 

• Listen to the word pronounced by clicking on the word. 

• To leave the Terms Book, click any button at the bottom of the screen to take you to another area of the
program or select an option under GoTo from the menu bar. 

• If you select a bolded word in the Field Guide, the QuickTerm window pops up over the Field Guide Page.
When you are finished reading the definition, click the DONE button to close the window and return to
the Field Guide page you were previously on. (See Field Guide for more information.)

• Any page of the Terms Book can be printed by selecting the print stamp button at the bottom of the
screen. 

• To take notes while using the Terms Book, click the JOURNAL button at the bottom of the screen. A note
pad will pop up over the Terms Book. (See Journal for more information.)

16
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data table
The Data Table is a database of specific information about all the animals, reptiles, amphibians, birds, insects,
and plants found in the Field Guide. 

NOTE:
Because of the rapidly changing status of tropical rainforests, Sunburst Communications cannot be responsible for
changes to species status listings in the Data Table after the CD-ROM has been published. Users are encouraged to
check the latest species information from CITES (Convention on International Trade and Endangered Species) and
IUCN (International Union for the Conservation of Nature and Natural Resources, also called The World Conservation
Union) to determine if the species is currently listed as extinct, endangered, threatened, vulnerable, or indeterminate.
(See Organizations at the end of this guide).

• There are two Data Tables in the program: Animal Data Table and Plant Data Table. If you are on the
Animal Data Table screen and want to go to the Plant Data Table, click the PLANT button in the upper
right-hand corner of the Data Table screen. If you are on the Plant Data Table screen and want to go to
the Animal Data Table, click the ANIMAL button in the upper right-hand corner of the Data Table screen.
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Animal Data Table
The Animal Data Table (see below) has 112 rainforest creatures classified in the following categories:

• Animal Name

• Activity—Day, Night, or both

• Status—Conservation Status: extinct, endangered, threatened, vulnerable, or indeterminate (See NOTE
on page 17.)

• Diet—herbivore, insectivore, carnivore, or omnivore*

• Class—amphibian, arachnid, bird, insect, mammal, or reptile

• Area—layers: canopy, understory, floor, or river

* As it applies to the entries in the Animal Data Table, please note that insectivore covers animals that eat only insects and those that eat
insects AND plants or plant matter. Carnivore refers to meat eaters as well as those creatures that eat insects and arachnids.

• To learn about any animal in the Data Table, click the name of the animal once so that it is highlighted.
Then click the FIELD GUIDE button at the bottom of the screen. To return to the Data Table again, click
the DATA TABLE button at the bottom of the screen. 

• To see any animal in the Data Table shown in its rainforest habitat, click the name of the animal once so
that is highlighted. Then click the GLOBE button at the bottom of the screen. To return to the Data Table
again, click the DATA TABLE button at the bottom of the screen. 

• To print the Data Table you see on the screen, click the PRINT STAMP button at the bottom of the screen. 
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Find Button
Select the FIND button to create a table of animals classified by their class, day or night activity, diet, status, or
rainforest area. A window pops up (see below) with categories from which to make a selection. For example,
you might wish to find and create a table of only those carnivorous animals that are most active during the day
and that are on the Endangered Species list.

• Once the selections are made, an alphabetical list is created of all the animals that meet the criteria specified
in the Find window. You can print the list by clicking the PRINT STAMP button at the bottom of the screen. 

• If an invalid selection is made, a pop-up window tells you that no matches have been found that fit the
criteria requested. 

• You can sort the information as many times as you wish. 

Sort Button
Select the SORT button to sort five categories of information in the Data Table: animal name, class, day or night
activity, diet, and status. A window pops up with categories from which to make a selection. For example, you
might wish to sort all animals in the Data Table by their Conservation Status, or by their day/night activity.

• Once the selections are made, an alphabetical list is created of all the animals that meet the criteria specified
in the Sort window. You can print the list by clicking the PRINT STAMP button at the bottom of the screen.

• If an invalid selection is made, a pop-up window tells you that no matches have been found that fit the
criteria requested. 

• You can sort the information as many times as you wish. 

Reset Button
Select the RESET button to return to the original Animal Data Table.
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Plant Data Table
The Plant Data Table (see below) has 52 plants classified in the following categories:

• Name of the plant

• Location—South America, Africa, or Southeast Asia

• Layer—Emergent, Canopy, Understory, or Floor

• Type—tree, shrub, epiphyte, fern, rhizome, lichen, vine, liana, fungus, flower, or herb

• Approximate maximum height of shrubs and trees and approximate maximum length of vines and lianas.

• To learn about any plant in the Data Table, click the name of the plant once so that it is highlighted.
Then click the FIELD GUIDE button at the bottom of the screen. To return to the Data Table again, click
the DATA TABLE button at the bottom of the screen. 

• To see any plant in the Data Table shown in its rainforest habitat, click the name of the plant once so
that is highlighted. Then click the GLOBE button at the bottom of the screen. To return to the Data Table
again, click the DATA TABLE button at the bottom of the screen. 

• To print the Data Table you see on the screen, click the PRINT STAMP button at the bottom of the screen. 
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Find Button
Select the FIND button to create a table of plants classified by their location, rainforest layer, or type. A window
pops up (see below) with categories from which to make a selection. For example, you might wish to find and
create a table of canopy layer trees in Southeast Asia only.

• Once the selections are made, an alphabetized list is created of all the plants that meet the criteria specified
in the Find window. You can print the table by clicking the PRINT STAMP button at the bottom of the screen.

• If an invalid selection is made, a pop-up window tells you that no matches have been found that fit the
criteria requested. 

• You can sort the information as many times as you wish. 

Sort Button
Select the SORT button to sort four categories of information in the Data Table: Name, Location, Layer, and
Type. A window pops up (see below) with categories from which to make a selection. For example, you might
wish to sort all plants in the Data Table by the layers they grow at in the rainforest.

• Once the selections are made, an alphabetical list is created of all the plants that meet the criteria specified
in the Sort window. You can print the list by clicking the PRINT STAMP button at the bottom of the screen. 

• If an invalid selection is made, a pop-up window tells you that no matches have been found that fit the
criteria requested. 

• You can sort the information as many times as you wish. 

Reset Button
Select the RESET button to return to the original Plant Data Table.
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journal
At any time during the program, you can click on the Journal icon to access the Rainforest word processor. The
journal tool allows you to take notes, create outlines and write research papers. You can take screen shots to be
used in your paper or import your own photographs.

Note Taker
Clicking on the Journal icon brings up the Note Taker pad. Here you can write down your thoughts or discover-
ies about the rainforest. Once you have finished taking notes, you can then click Rainforest to go back to the
program, or click the JOURNAL button to go to the Journal. If you click JOURNAL, a dialog will ask you whether
you want to transfer your Note Taker notes into the Journal.

Using the Journal
You can use the Journal to pull together your Note Taker notes and Camera screen shots. The Journal also con-
tains a number of formatting options that you can use to put together well-organized, attractive-looking docu-
ments to share with your teacher, friends, and parents.
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Getting Started
When you enter the Journal from the Note Taker, a dialog will ask you where you want to transfer your Note
Taker notes to: a new journal or a saved journal. Make your choice by clicking the appropriate button—NEW

JOURNAL, SAVED JOURNAL, or CANCEL. If you click NEW or SAVED JOURNAL, the latest Camera picture(s) will be
loaded with your notes.

If you choose CANCEL, you can always add your notes later by selecting Load Notes from the Extras menu.

Setting Font and Style for the Document
To change the default font, font size, and text style for the document, select Text Style... from the Style menu or
Set Font... from the Font menu. Set the font type and size for your document, and click OK to close the dialog.

Selecting Text
To use some of the editing and formatting commands available in the menus, you need to select the text you
want to change. Click and drag with the mouse to select text, double-click to select a single word, or choose
Select All from the Edit menu to change all the text in your document.

Changing Font, Style, Size, and Justification
You can select text and then change the font, style, size, and justification to make it stand out from the rest of
your document. 

To change the font of selected text, choose a new font from the Font menu. The list of fonts in the Font menu
is based on the fonts installed on your computer.

To change the style of the selected text, choose a new style (Plain, Bold, Italic, or Underline) from the Style
menu. For Bold, Italic, and Underline, you can also use the shortcut buttons in the button bar.

To change the size of the selected text, choose a new size (10, 12, 14, 18, or 24 point) from the Style menu.

To change the justification of the selected text, choose Left, Right, or Center Justify from the Style menu, or
use the shortcut buttons in the button bar.

Editing With Cut, Copy, and Paste
You can use the Cut, Copy, and Paste commands to edit and organize your writing. Remember, though, that the
clipboard can only hold one thing at a time, so if you cut one paragraph and then copy a picture, only the pic-
ture will be on the clipboard.

To move a selected section of text or picture from one place to another, select Cut from the Edit menu. The
text or picture will be removed from the document and placed on the clipboard. Click the mouse to put the
cursor where you want to move the paragraph or picture and then select Paste from the Edit menu.

To use a selected section of text or picture in more than one place, select Copy from the Edit menu. A copy of
your selection will be placed on the clipboard, leaving the original in your document. Click the mouse to put
the cursor where you want to add the text or picture and then select Paste from the Edit menu.
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Checking Spelling
To check your spelling, select Spell Checker from the Extras menu. The Spell Checker will begin to check your
text, starting from the beginning of the Journal.

If the Spell Checker finds a word it doesn’t recognize, the Check Spelling dialog will appear. The dialog will
show you the word that is not in the dictionary, along with a list of suggestions.

To change the word, click a suggestion in the list to highlight it and then click REPLACE to replace the word there,
or click REPLACE ALL to replace the word throughout the Journal. You can also correct the word by retyping it.

To add the word to your dictionary, click ADD TO DICTIONARY. You can also see the list of words in your dictio-
nary by clicking the DICTIONARY button.

To skip the word and continue, click SKIP. If you want to skip the word every time the Spell Checker sees it,
click SKIP ALL.

When the Spell Checker is finished, you’ll see a message that it is done. Click OK to return to the Journal.

Adding a Picture
If you want to add a picture, select Add Picture from the Extras menu. A dialog will appear. Use the dialog to
find the picture you want to add and click OK. The picture will be added to your document.

Changing the Size of a Picture
To make a selected picture larger, choose Make Picture Larger from the Extras menu. To make a selected picture
smaller, choose Make Picture Smaller from the Extras menu.

Saving Your Work
To save your work, choose Save from the File menu or click SAVE in the button bar. A dialog will appear. Enter
a name for your work, choose a location to store it, and click SAVE. 

Note: Windows users of A Field Trip to the Rainforest Deluxe must name your documents with the suffix .jnl or you
won’t be abled to open them again in the Journal.

To save your work under a new name, select Save As from the File menu. A dialog will appear. Rename your
work and click OK.
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Printing Your Work
To print your work, select Print from the File menu or click the PRINT button in the button bar. A Print
Preview dialog will appear to show you what your printout will look like.

Use the arrows at the top right of the dialog to set the number of copies you want to print.

Click the PRINT ALL button to print your entire Journal, or click the button by From and To in order to print a
portion of your Journal. Enter the page range in the boxes provided.

When you are ready to send the Journal to the printer, click PRINT.

Creating a New Document
To start a new document, select New from the File menu. If you haven’t saved your work, a dialog will appear to
let you save. After you have saved, a new document window will appear.

Opening a Document
To open an existing document, select Open from the File menu. A dialog will appear. Click the name of your
file and click OPEN.

Leaving the Journal
To leave the Journal and go back to the activity, click RETURN TO PROGRAM. To exit the Journal and A Field
Trip to the Rainforest Deluxe, select Exit from the File menu.
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Camera
You can take pictures of your work with the Camera and add them to the Journal. When you click the CAMERA

button, a crosshairs cursor appears. Click and drag to select an area to photograph. When you release the
mouse, a dialog appears to ask if you want to save the picture. Click YES to save the picture, or click NO to dis-
card it.

You can take multiple pictures of your work, and then add them to the Journal.

When you go into the Journal, a dialog will appear to ask if you want to load your notes. Click OK to automati-
cally add the pictures you have taken. If you don’t want to add the pictures when you first start writing, you can
also add them later by choosing the Load Notes command from the Journal’s Extras menu. 
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fun facts activity
The Fun Facts Activity is a trivia game to test a player’s knowledge of what he or she has learned about tropical
rainforests. The activity questions are multiple choice and true or false.

• To begin the game, click any square in the game board and a question will move into the square. Answer
the question by clicking the correct large yellow letter (A, B, C, or D) on the right side of the screen, or
by clicking the correct answer in the question box. Multiple choice questions offer four possible answers;
true or false are represented as T or F.

• If the answer is correct, you will hear a musical sound and the explanation of the answer will appear. In
about five seconds the answer is replaced by one piece of a hidden photograph. Click another question on
the game board to continue the game. 

• If the answer is incorrect, you will hear a thumping sound and the explanation of the correct answer will
appear. Wait about five seconds or click the square again and a new puzzle piece covers the square. Click
the square to try another question.

• The game is over when all questions have been answered correctly, revealing a beautiful photo of a 
rainforest. 

• Click the NEW GAME button on the top right side of the screen to play a new game with different trivia
questions. The Fun Facts game contains more than 150 questions in all.
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Goals
• Become familiar with A Field Trip to the Rainforest Deluxe.

• Develop divergent thinking skills.

• Read for specific information about tropical rainforests.

National Science Education Standards
Content Standard A: Science as Inquiry
Understandings About Scientific Inquiry

Materials
• A Field Trip to the Rainforest Deluxe

• Rainforest Scavenger Hunt Blackline Master

Using the Activity
Help students become familiar with A Field Trip to the Rainforest Deluxe by taking them on a virtual scavenger
hunt. Students can work individually, in pairs, or in small groups at the computer. Distribute the Rainforest
Scavenger Hunt Blackline Master, and encourage students to explore all parts of the Field Trip program to find
answers to the clues. 

All of the clues are purposely open-ended so that students think critically about each clue and generate many
different possible answers.  You may wish to review one or two of the clues with the class before they begin
work on their own. Be sure to emphasize that there is not only one right answer for each clue. In fact, there are
several correct answers for each clue. (See Answer Key on next page.) Tell students that their task is to use the
Field Trip program to do careful investigations and to come up with good answers.

After students complete the Rainforest Scavenger Hunt, invite them to share their answers. How many unique
answers were there for each clue? Ask students what method they used to “collect” answers. Did they have a
special technique for searching through the Discovery Screen or Field Guide? Were there any clues for which
they couldn’t find answers? 
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Answer Key
Answers will vary for all of the Rainforest Scavenger Hunt clues. Following are just a few examples of the kinds
of responses students may contribute for each clue.

1. A seed spreader: animals, plants, insects, birds, wind, people or water

2. A highway: vines, lianas connecting trees in the canopy, man-made roads through the forest

3. A trap: pitcher plant, trap-door spider’s home

4. A plant used for medicine: any one of many plants described in the program

5. A colorful warning: birds with colorful feathers, poison arrow frogs, and other creatures that use color to
warn predators to stay away

6. Something found in the rainforest that can be used more then once: all renewable resources such as rub-
ber tapped from trees, spices, fruit, chicle, nuts, and rattan

7. Something found in the rainforest that can’t be replaced once it is used up: hardwoods and other materials
that come from destroying trees, plants, and animals

8. Something enormous: emergent layer trees, giant millipede, giant otter, giant anteater, giant armadillo,
rafflesia flower, bush babies’ eyes, blue morpho butterfly

9. A cycle: Earth’s water cycle, the natural recycling of dead or decaying plant and animal matter, food webs

10. Something you learned about the rainforest that you never knew before: answers will vary.

Extension Activities
1. Create models or shoebox dioramas of individual scavenger hunt clues. For example, a student might make

a papier mâché model of a brightly-colored poison arrow frog to represent the clue “a colorful warning.”

2. Have students use the Field Trip Journal to write creative stories based on one of the clues, e.g., “A day in
the life of a seed spreader” or “The insect that wouldn’t get trapped.” Remind students that they can take
pictures and then place and move them in the Journal to illustrate their stories.

3. Ask students to create a world map on a large sheet of butcher paper, identifying all the remaining tropi-
cal rainforests. Encourage older students to determine the latitude and longitude of all rainforest regions.
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Use A Field Trip to the Rainforest Deluxe to find at least one example for each of the clues
shown below. Remember, there is no one right answer to any of the clues.
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Clues Examples

1. A seed spreader

2. A highway

3. A trap

4. A plant used for
medicine

5. A colorful 
warning

6. Something found
in the rainforest
that can be used
more then once

7. Something found
in the rainforest
that can’t be
replaced once it
is used up

8. Something 
enormous

9. A cycle

10.Something you
learned about
the rainforest
that you never
knew before



Goals
• Learn how animals and plants living in rainforests have adapted to survive in their unique environments.

• Learn about methods of camouflage, mimicry, and physical adaptations in nature.

National Science Education Standards
Content Standard C: Life Science
Diversity and Adaptations of Organisms

Materials
• A Field Trip to the Rainforest Deluxe

• Adaptations Chart Blackline Master

Activity
It really is a jungle out there in the tropics! In order to stay alive, animals and plants living in rainforests have
developed amazing adaptations, behaviors, and tricks to survive. For example, some boa constrictors have pits
on their heads to detect prey. Bats have large ears to help with echolocation. Woolly monkeys use their prehen-
sile tails and opposable thumbs to swing through the rainforest canopy with ease. 

Ask students to select five animals, insects, amphibians, reptiles, birds, and/or plants about which they are most
interested in learning. Give them ample time to search the Discovery Screen, Field Guide, and Data Table to
find the organisms they want to research. Distribute the Adaptations Chart Blackline Master, and have them
complete it by naming the species, describing its special adaptation(s) and the function of each adaptation. For
example, the panther toad has an adaptation which enables it to retract its eyes into their sockets so that they
bulge against the roof of its mouth to help with swallowing.

When they have completed their Adaptations Charts, have students share their findings with the class. You
might wish to create one large chart showing all of the species students researched. Follow up with a discussion
about how adaptations help humans live more efficiently. For example, our opposable thumbs sure are handy
adaptations. (To prove your point, have students tape their thumbs to their hands and then try to turn the
pages of a book or tie their shoelaces.) Ask what adaptations other animals have that they wish humans had.
Why? Would it help if we had prehensile tails or wings?
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Extension Activities
1. Have students use basic art materials to design a fictional animal or plant which is adapted to their own

school yard or classroom habitat. Students can invent a name for their organism, write a description of its
natural habitat, diet, natural enemies, and any special adaptations or abilities it may have to live more
efficiently. Culminate the activity by having students hide their creatures in their “habitats.” Once hid-
den, have the class search for them. As each organism is found, ask its creator to explain its adaptations.
For example, if it was found high in a tree, the organism will need to have been made with wings, claws,
or other structures which would enable it to get into a tree. Plants would need to be placed where they
could get ample food and sunlight.

2. Ask students to look at the Field Guide illustrations of animals and birds and then look at the types of
food each eats. Determine whether or not each creature has a physical characteristic or ability that
enables it to capture and eat the food. 

3. Use the Journal to write stories about unusual, fictional adaptations that students wish their own bodies
had! (Perhaps they’d like an appendage that would do their homework for them while they were doing
other activities.)
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Select five animals, insects, amphibians, reptiles, birds, or plants from A Field Trip to the
Rainforest Deluxe that you are interested in learning about. Then complete the chart by writing
the name of the species you chose, a description of any special adaptations it has, and how
each adaptation helps the species better survive in the rainforest.
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Name of Species Description of Adaptation(s) Function of Adaptation(s)

1.

2.

3.

4.

5.



Goals
• Learn how energy flows through food chains.

• Classify organisms by whether they are producers, consumers, or decomposers.  

• Create a graphic organizer to represent a simple food chain.

National Science Education Standards
Content Standard C: Life Science
• Organisms and Their Environment

• Populations and Ecosystems

• The Interdependence of Organisms

Materials
• A Field Trip to the Rainforest Deluxe

• Food Chain Blackline Master

Activity
Organisms living in rainforests get energy by eating other organisms. The transfer of that energy is called a food
chain or food web. Tropical rainforests have thousands of complex food chains. All organisms in a food chain
are classified into three main groups: producer, consumer, or decomposer. Producers come first in the chain
since they use sunlight to make their own food. This group is made up mostly of plants. Next in line are con-
sumers which include animals that eat plants (herbivores), followed by omnivores (plant and meat eaters), and
then carnivores (meat/insect eaters). Decomposers, like bacteria and fungi, end off the chain by helping to
break down dead plants and animals and recycle nutrients back into the soil and the forest food chains.

On the chalkboard, draw an example of a rainforest food chain: 

brazil nut tree ➔ agouti ➔ snake ➔ eagle ➔ earthworm

Help students understand that the leaves, nuts, and fruit of the brazil nut tree are eaten by the agouti which, in
turn, is eaten by a snake. The eagle eats the snake and when the eagle dies, its remains are broken down by
earthworms whose waste returns minerals and nutrients to the soil. Plants and trees feed off the nutrients and
the cycle begins again.

Distribute the Food Chain Blackline Master and invite students to select one animal, bird, insect, reptile,
amphibian, or plant that interests them from the Field Trip program. Have them research the organism to dis-
cover how and where it fits into a food chain and then complete the Food Chain worksheet. Encourage them
to use the Terms Book in order to review such vocabulary as herbivore, omnivore, and carnivore.
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Extension Activities
1. Have students conduct a simple experiment to prove that plants (producers) are indeed capable of manu-

facturing their own food. Cover a leaf with boiling water for a few minutes and then place it in rubbing
alcohol to remove the green pigment (chlorophyll). Then place the leaf in iodine. Tell students that a
bluish/black color indicates starch. Have students also try putting iodine on other things such as a pebble,
a piece of bread, or a carrot. Which contain starch? 

2. Ask students to think about what they ate for breakfast this morning. Have them create a diagram of the
plant and/or animal groups they consumed. In place of a chart, younger students will enjoy making repre-
sentations of food chains out of paper strips, linked and glued together.

3. To better illustrate the impact of logging or burning of rainforests on the food chains, assign each student
a role as a producer, consumer, or decomposer. Have them write their plant or animal on an index card
and tape it to their chests. One student should play the role of the sun and stand in the middle of the
room, holding a ball of string. The producers should then stand in a circle around the sun. The sun should
pass the string to one producer, who then passes it back to the sun. Repeat the procedure until all produc-
ers are holding at least one segment of the string. Continue the activity until all students, one by one,
take their place in the food web, passing and holding segments of the string. Students will easily see the
complex interconnections of a food web. 

To further challenge them, ask students what they think might happen if all the students representing forest
plants and trees were to disappear; in other words, what happens to the rainforest food webs when plants and
trees are logged or burned down? Ask all students representing foliage to gently tug on the pieces of string they
are holding. Eventually all students will feel at least one pull. After this dramatization, have students discuss
their actions and observations.
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Select an animal or other organism and complete the food chain. 
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Goals
• Learn about the conservation status of tropical rainforest species.

• Sort information in a database.

• Gather and organize information in a pie graph. 

National Science Education Standards
Content Standard C: Life Science
• Organisms and Their Environment

• Diversity and Adaptations of Organisms

Materials
• A Field Trip to the Rainforest Deluxe

• Conservation Status Pie Graph

• markers or colored pencils

Activity
Help students understand that organizations such as the FWS (U.S. Fish and Wildlife Service), CITES
(Convention on International Trade and Endangered Species), and IUCN (International Union for the
Conservation of Nature, also called The World Conservation Union) keep a watchful eye on the status of plant
and animal species around the world. Their goal is to help promote the protection of all “endangered and
threatened living resources.” They keep conservation status lists classifying species as extinct, endangered,
threatened, vulnerable, indeterminate, or out of danger. These lists keep changing as humans continue to popu-
late areas where wildlife live.

Have students use the Terms Book to find the definitions of endangered, threatened, vulnerable, and indeterminate.
Note that species are listed as “indeterminate” or given a label of “no status” when there isn’t enough informa-
tion to make a classification. This is happening more and more in tropical rainforests. Some rainforests are
being destroyed so rapidly that CITES and IUCN can’t get into the areas quickly enough to determine how the
species are doing.

Ask students to use the Data Table to sort all animal species by their conservation status. Print the sorted Data
Table and count the number of species in each category. Distribute the Conservation Status Pie Graph and
have students divide the circle into sections to represent the totals. For example, there are more endangered
species than threatened species, so the endangered piece of the pie would be larger. Older students may wish to
convert the numbers to percentages.  
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Extension Activities
1. Have interested students research The Endangered Species Preservation Act of 1966 and the Endangered

Species Conservation Act of 1969.  Compare these Acts with the Endangered Species Act of 1973. What
are the main differences? (The Acts in the 1960s expressed concern for the world’s disappearing species,
but did nothing to actually protect the species from further destruction. The 1973 Act, however, made it
illegal for anyone in the United States to injure, capture, or kill any species identified as endangered or
threatened.)

2. Create a mural depicting endangered tropical rainforest species. 

3. Have students compile a list of endangered or threatened animals and the specific reasons those animals are
in danger (e.g., habitat loss due to slash-and-burn practices, illegal pet trade, and the sales of furs and skins).
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Divide the circle into sections representing the total numbers of species you found on A Field
Trip to the Rainforest Deluxe that are endangered, threatened, vulnerable, indeterminate, or out
of danger. Label each area and shade each section in a different color.
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Goals
• Learn about and illustrate the water cycle.

• Understand how the cycling of water in and out of the atmosphere plays an important role in determining
the world’s climates.

• Formulate questions about nature.

National Science Education Standards
Content Standard D: Earth and Space Science
• Structure of the Earth System

Materials
• A Field Trip to the Rainforest Deluxe

• poster board or large pieces of butcher paper

• markers, crayons, water colors, or other coloring materials

Activity
There is a reason rainforests are called rainforests! On the average, tropical rainforests get 60 to 80 inches of
rain per year, but some receive much, much more. Have students learn about rainfall amounts by reading the
Field Guide Introduction.

Ask students if they know how rain forms. Why do some parts of the Earth get a lot while other areas, like
deserts, get so little? Help students to understand how the Earth distributes water through evaporation and con-
densation. Define the water cycle as the movement of water from the Earth, into the atmosphere, and then
back to the Earth. Water from oceans, rivers, lakes, and plants continually evaporates from the sun’s heat. Some
of this evaporated water is suspended in the atmosphere in the form of water vapor. The water vapor rises and
forms clouds through condensation. When the clouds accumulate more water vapor than they can hold, the
water falls back to the ground as rain. (In colder climates, it falls as snow.)  Encourage students to use the Terms
Book to learn the definitions of such words as atmosphere and climate.

Have students create posters showing the water cycle at work in tropical rainforests. When complete, display
the posters around the classroom and ask students to describe orally what they’ve illustrated. 
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Extension Activities
1. Create a water cycle using water, salt, and plastic bags. Have students fill jars with 8 oz. water. Mix 1 tsp.

of salt into each to simulate ocean water. Cover each jar with a clear sandwich bag, attach it with a rub-
ber band, and set the jar in the sun. Have students observe the jars daily and keep a written record of
their observations. Ask them how they think these jars represent a water cycle. (As heat evaporates the
water, it rises and droplets of water collect on the tops and sides of the jars. As it cools, the water con-
denses and runs back down into the jars as “rain.”)

2. Have students use the Journal to write creative myths or stories to “explain” what causes rain or weather. 

3. Help students understand that plants and trees also lose water through their leaves through a process
called transpiration. This water evaporates into the atmosphere along with the moisture from oceans,
lakes, and rivers. Have students tie a clear, plastic bag around the end of a leafy branch of a tree in the
school yard. Observe the bag each hour. Students should see water condensation in the bag, depending on
the time of the day and the weather. Don’t forget to remove the bags when you are done!
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Goals
• Learn about symbiotic relationships between plants and/or animals in tropical rainforest ecosystems.

• Differentiate between mutualism and parasitism in rainforest species.

• Construct a chart to organize information. 

National Science Education Standards
Content Standard C: Life Science
• The Characteristics of Organisms

• Populations and Ecosystems

• The Interdependence of Organisms

Materials
• A Field Trip to the Rainforest Deluxe

• Partners Blackline Master

Activity
In tropical rainforests, many plants and animals form partnerships to survive. This type of close living relation-
ship between two different species is called symbiosis. Some of these partnerships benefit both organisms, but
other partnerships can be harmful, or even fatal, to one of the organisms. 

In the first type of relationship, called mutualism, both organisms benefit from the partnership. For example,
mutualism exists between one species of ant and the acacia tree because the ants protect the tree and in turn,
the tree feeds and provides shelter for the ants.  In the second type of relationship, called parasitism, one of the
organisms is harmed or is killed by the partnership. Parasites are organisms that live on or in another organism.
An example of such a relationship is the wasp and the trap-door spider. The wasp lays its eggs in the eggs of the
spiders, so that when the wasp larvae hatch, they feed on the developing spiders and kill them.  

Have students use the Field Guide and Discovery Screen to find examples of partnerships in the rainforest.
Encourage them to look for examples of organisms that might not be so obvious, such as the brazil nut tree
which could not exist without the agouti to disperse its seeds or orchid bees to pollinate it. 

Distribute the Partners Blackline Master and have students complete the chart by identifying four sets of part-
ners. Students can select two animals, an animal and an insect, an animal and a plant, or two plants. Ask them
to describe the relationship between the two organisms and identify whether it is an example of mutualism or
parasitism. 
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Some examples of mutualism: cercropia tree/azteca ants, mycorrhizal fungi/orchid, fruit bat/flowers, sloth/algae,
cyprinid fish/pygmy hippo, bacteria/red colobus monkey

Some examples of parasitism: wasp/trap-door spider, strangler fig/cercropia tree, flies/panther toad

NOTE:
To challenge older students, you might also wish to have them identify two more types of symbiotic relationships:
helotism and commensalism. Helotism exists in lichen because the fungi controls the algae by forcing it to live on the
plant. Point out that scientists disagree about lichen’s partnership. While some think the fungi forces the algae to live
on it, others think the algae and fungi are both benefited from the relationship. Commensalism describes the relation-
ship between two organisms in which one benefits, but the other is neither harmed nor helped. An example of such a
relationship is a seed that attaches itself to fur or feathers, or the Nile monitor which lays its eggs in soft termite
mounds. 

Extension Activities
1. Illustrate the partners sets described on the chart. Students can attach index cards to their illustrations,

describing the partnerships in detail. Display their artwork around the classroom.

2. John Muir once said, “When we try to pick out anything by itself we find it hitched to everything else in
the universe.” Ask students to write a paragraph in the Journal about how this relates to partnerships
among plants and animals in the rainforest. 

3. Mycorrhizal fungi partners with many other living organisms in the rainforest, including canopy trees.  All
fungi in rainforests are essential to the forest ecosystem. After reading about mycorrhizal fungi in the Field
Guide, students can grow their own mold, which is a common form of fungus that can’t make its own
food. Moisten a paper towel and place it in the bottom of a glass jar. Put a piece of white bread in the
open jar and leave it there for 30 minutes. Put the lid on the jar and store it in a dark cabinet for about
one week. Students can take the jar out each day to observe how the mold is growing. 
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In tropical rainforests, many plants and animals form partnerships to survive. Some of these
partnerships (called mutualism) benefit both organisms, but other partnerships can be harmful,
or even deadly, to one of the organisms (called parasitism). 

Complete the chart by describing four different partnerships in the rainforest.
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Goals
• Sort information in a database.

• Create a Venn diagram to compare and contrast information. 

• Differentiate between diurnal and nocturnal rainforest species.

National Science Education Standards
Content Standard A: Science as Inquiry
• Understandings About Scientific Inquiry

Content Standard C: Life Science
• The Characteristics of Organisms

• Organisms and Their Environment

• Regulation and Behavior

Materials
• A Field Trip to the Rainforest Deluxe

• Rainforest Species Blackline Master

Activity
Have students select the Data Table to gather and sort information about animals, reptiles, amphibians, birds,
and insects living in the rainforest. Ask students to sort information by rainforest layer (canopy, understory,
river, floor) making sure they focus on only one layer at a time. Then, ask students to sort each layer by
whether an organism living in it is diurnal (active during the day) or nocturnal (active at night). 

Once they have a list of those creatures that are diurnal or nocturnal, ask students to use the Field Guide to
learn more about each of these creatures. Engage students in a discussion about the kinds of physical character-
istics or special adaptations diurnal creatures have that nocturnal creatures don’t, and vice-versa. For example,
nocturnal animals tend to have very large eyes and very sensitive ears and noses. Smaller rainforest animals that
forage for food on the ground tend to be nocturnal because they wouldn’t want to be roaming the forest floor
during daylight when they could easily be spotted by predators. Diurnal animals are often masters of camouflage
or they use bright colors to frighten predators.

Illustrate how to complete a simple Venn diagram by drawing two overlapping circles on a chalkboard. Label
one of the circles “cat” and the other “dog.” Ask students to generate a list of some characteristics of a cat.
Write their responses in the cat circle. Repeat the process for the dog. Ask students if any of the items written
in the circles are the same. Move similar items (i.e., four paws, house pets) to the area where the circles over-
lap.  Help students understand how the overlapping area represents characteristics that both cats and dogs have
in common. 

46A Field Trip to the Rainforest Deluxe

whoÕs awake?



Distribute the Rainforest Species Blackline Master and ask students to compare and contrast characteristics of
diurnal and nocturnal creatures. Students should come up with similarities, differences, and things they share in
common.

Extension Activities
1. Discover what creatures are wandering around the school grounds day and night. Have students leave a

tray of baking soda or fine sand in certain areas on the yard. They should attach index cards to each tray
noting “Do Not Disturb: Experiment in Progress.” Have them check for tracks or any other evidence of
insects, birds, or animals each day. 

2. Use the Journal to write creative stories about diurnal or nocturnal creatures in the forest. 

3. Have interested students create a large Venn diagram or chart comparing domestic animals that are diur-
nal and nocturnal. They may want to do a class survey to find out how many of their classmates have
rodents, cats, or dogs as pets. Do domestic animals share the same physical characteristics and adaptations
as their wild cousins living in rainforests?
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Goals
• Create a bar graph to compare information.

• Compare lengths of snakes living in the rainforest.

• Measure and compare heights and lengths.

National Science Education Standards
Content Standard A: Science As Inquiry
• Abilities Necessary to Do Scientific Inquiry

Materials
• A Field Trip to the Rainforest Deluxe

• Measuring Up Blackline Master

• tape measure or yardstick

Activity
Many creatures that live in the rainforest show signs of gigantism, growing to unusually large sizes. Some exam-
ples include the huge rafflesia flower, emergent layer trees, the blue morpho butterfly, giant millipedes, and
many snakes including the anaconda, the world’s largest snake. 

Distribute the Measuring Up Blackline Master and have students search the Field Guide and Discovery Screen
to research the maximum recorded lengths of the various snakes. Have them record the numbers by shading in
the bar graph. For the final measurement—themselves—have pairs of students use measuring tapes or yardsticks
to measure each others’ heights (converting inches to feet). Students can add those numbers to the graph and
compare their own heights to the length of some snakes living in the rainforest.

Extension Activities
1. To help students visualize the enormity of many rainforest species, have them use chalk (on the school

yard) to mark the length of the snakes, the wingspan of the morpho butterfly, the width of the rafflesia
flower, etc.

2. Have students design a “Giants of the Rainforest” poster, illustrating the unique organisms that grow so large. 

3. Make life-sized papier mâché rainforest creatures that exhibit gigantism. Use chicken wire as the base for
the animals to make them sturdier. Hang understory and canopy creatures from the ceiling. 
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Goals
• Understand the complex problems of deforestation.

• Create a graphic organizer to illustrate one cause of deforestation and its many effects.

National Science Education Standards
Content Standard C: Life Science
• Organisms and Their Environment

Content Standard F: Science in Personal and Social Perspectives
• Populations, Resources, and Environment

• Natural Resources

• Natural and Human-Induced Hazards

Materials
• A Field Trip to the Rainforest Deluxe

• Cause and Effect Map Blackline Master

Activity
There are many causes of rainforest destruction and there are no easy solutions. Students can learn about the
various issues surrounding deforestation and the subsequent effects by reading the Future of the Rainforest sec-
tion of the Field Guide.

Engage students in a short discussion about what they’ve learned. On the chalkboard, draw a graphic organizer,
like the one shown here, to help organize information. Ask students to generate information and complete the
chart by adding bubbles with information as applicable. The middle box should state the cause of the destruction. 
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Distribute the Cause and Effect Map Blackline Master and ask students to select one of the following issues that
interests them the most: slash-and-burn agriculture, logging, ranching, or mining. In the circle shown on the
sheet, have them write the issue. Then have them add the effects of that issue or action they wrote in the cir-
cle. Have them use arrows as was shown in the chalkboard example.

After the activity is done, have students share their graphic representations of the causes and effects of rainfor-
est destruction and encourage them to discuss possible solutions to these problems.

Extension Activities
1. Challenge teams of students to come up with simple experiments to show how plants help prevent soil

erosion. For example, students can fill one shallow baking pan with dirt and another with sod. Punch a
hole at the end of each pan to allow the water to run off. Have them tilt each pan over a sink or contain-
er and slowly pour water from watering cans over them to simulate rain. Students can observe which pan
retains the soil.

2. Have a group of interested students create a “greenhouse effect” by filling two cups with the same amount
of cool water and putting them both in direct sunlight. Cover one cup with an inverted large glass bowl.
After two hours or so, have students use thermometers to check the water temperatures in each cup. Ask
students to explain why the cup under the glass dome is warmer and how this relates to the earth. (The
earth can’t cool off when heat is trapped.)

3. Create a large mural illustrating the many causes and effects of rainforest destruction. 
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Write one cause of rainforest destruction in the middle circle. Then use arrows and more circles to show the
effects the destruction has on the entire rainforest. Add as many circles and arrows as you need.
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Goals
• Debate the complex issues surrounding rainforest destruction.

• Brainstorm possible solutions to problems.

• Learn to think about issues from another person’s point of view.

• Work cooperatively to solve a problem. 

National Science Education Standards
Content Standard F: Science in Personal and Social Perspectives
• Changes in Environments

• Populations, Resources, and Environments

• Environmental Quality

Content Standard G: History and Nature of Science
• Science As a Human Endeavor

Materials
• A Field Trip to the Rainforest Deluxe

• Problem/Solution Chart Blackline Master

Using the Activity
Help students begin to unravel some of the complicated issues involved in rainforest destruction by inviting
them to take on the roles of different people living and working in rainforests. Set the scene by telling students
that 10,000 acres of tropical rainforest is scheduled to be logged and burned to make room for a road, a hydro-
electric plant, and some cattle ranches. A committee, made up of people living and working in the rainforest,
has been formed to debate the issues and to try to come up with some possible solutions. 

Divide students into small groups so that each student in the group can take on a different character role. Each
team can have: a representative from an indigenous tribe, a miner, a farmer, an environmental studies student, a
rubber tapper, a representative from the energy plant, a cattle rancher, a zoologist, an anthropologist, and a
botanist. (You may need to add or subtract roles, depending on the size of the teams.)

Have each team read the Field Guide: People of the Rainforest to discover what the issues are and to think
about how their characters might respond in a debate. Ask them to use the Journal to take any notes to use dur-
ing the debate and to complete the Problem/Solution Chart afterwards. Remind students that issues surround-
ing tropical rainforests aren’t easy. Have them read the Field Guide: Reasons for Destruction. You might want to
discuss some of the main issues as a whole class, to help students get a better sense of how their characters
might comment. For example, a rubber tapper would be in favor of stopping the destruction because he earns
money from the forest when it is left intact. A cattle rancher, on the other hand, makes money only when there
is room to raise cattle.
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Once research is complete, ask students to debate the issues aloud, in character. Are compromises possible?
When the debate is complete, distribute the Problem/Solution Chart. Have students write about four specific
problems raised in the debate, possible solutions or compromises to the problems, and pros and cons of those
solutions. 

Extension Activities
1. Encourage students to clip articles from local newspapers and create a classroom bulletin board of ecologi-

cal issues going on right now in your community. How are they being debated or resolved? What solutions
or compromises would students suggest?

2. Use the Journal to write a letter or a position statement from the viewpoint of each character in the
debate. 

3. Have a group of students write letters or visit the Web sites of environmental organizations (see the
Organizations list, page 60) working to protect the world’s rainforests. Have them report back to the class
about the kinds of things these organizations are doing and how individuals can help. 
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Pick five problems that are occurring right now in tropical rainforests. Then think of one or more possible solu-
tions to the problem. What are the pros and cons of those solutions?
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3.

4.
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Goals
• Demonstrate an increase in knowledge about tropical rainforests through oral and written responses. 

• Formulate questions about nature. 

National Science Education Standards
Content Standard A: Scientific Inquiry
• Abilities Necessary to Do Scientific Inquiry

Materials
• A Field Trip to the Rainforest Deluxe

Activity
Have students play the Fun Facts activity in the Field Trip program to test their knowledge and understanding of
the rainforest. After doing so, challenge students to create their own rainforest trivia or stumpers to challenge
their classmates.  Students might want to work in small groups, having one group challenge another. Each stu-
dent should come up with three rainforest “stumpers.” They can be written as clues, riddles, or even in rhyme.
For example, 

“I grow really tall and my branches are very strong. 
My fruit looks like apples.
Gum chewers love me. 
What am I?”
(Answer: Sapodilla tree)

Students can write their rainforest stumpers using the Journal. Print and post one or two stumpers in the class-
room each day and challenge students to write their answers on slips of paper. Collect the slips and, at the end
of the day, read the clues and the correct answer.

Extension Activities
1. Write and illustrate a class book of rainforest trivia to share with younger students.  

2. Use the Journal to write narrative “Just-So” stories, such as “Why the Blue Morpho Butterfly is so blue,”
or “How the kapok tree grew so tall.”

3. Play a game of charades in which students take turns imitating various rainforest animals. The student
who correctly identifies the mystery animal takes the next turn.

57A Field Trip to the Rainforest Deluxe

rainforest stumpers



Goals
• Write a consumer’s guide to sustainable rainforest products.

• Understand that rainforests can be used in sustainable and non-sustainable ways.

• Understand that the purchase of sustainable rainforest products helps to keep the rainforests standing. 

National Science Education Standards
Content Standard F: Science in Personal and Social Perspectives
• Types of Resources

• Changes in Environments

• Natural Resources

Materials
• A Field Trip to the Rainforest Deluxe

• markers, crayons, or other coloring materials (optional)

Activity
Have students research the Rainforest Resources section of the Field Guide to learn about the rainforest’s sus-
tainable and non-sustainable resources. Remind students that sustainable means using rainforest resources in
ways that don’t harm them so that they can be used over and over again.

Divide students into pairs or small groups to create a “Consumer Guide” to sustainable rainforest products. Help
students develop their writing skills by reminding them to summarize and reword what is already written in the
Field Guide instead of just copying the written text into the Journal. Students may also wish to use the camera
to take screen shots of the artwork in the program.

Encourage creativity! Students can put recipes in their guides, such as Rainforest Trail Mix which would use
nuts, spices, and fruits that grow in the tropics. They might also wish to include tips on how to be a wise con-
sumer. (See What You Can Do section of the Field Guide.) Ask students to think about what their school
might do to help preserve rainforests.  

When the guides are complete, print them; students might wish to decorate them using markers or other color-
ing materials. Bind the guides or put them in notebooks. You may want to ask the school librarian to catalog
the guides so that other students in the school can check them out.
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Extension Activities
1. Divide students into small groups to research such companies as The Body Shop and Ben and Jerry’s Ice

Cream that purchase sustainable resources harvested in rainforests. (They donate a large portion of the
profits to indigenous communities and to environmental organizations.)

2. Perform skits for other classes in the school to help them understand what is happening to tropical rain-
forests and how people are helping to stop their destruction.  

3. If you have Internet access, create a class Web site dedicated to providing information about tropical rain-
forests. Sunburst’s School Version of Web Workshop is an easy way to get students started as Web designers.
Encourage students to publish their writings, illustrations, and research on the Web site, and link to other
rainforest information sites on the Web. (See the Organizations list, page 60.)
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organizations
Following is a list of organizations that are working to save the world’s remaining tropical
rainforests and the species living in them.

Conservation International
1015 18th Street, NW
Suite 1000
Washington, D.C. 20036
Phone: 202-429-5660
Internet: http://www.conservation.org

International Primate Protection League
P.O. Box 766
Summerville, SC 29484
Internet: http://www.sims.net/organizations/ippl/ippl.html

International Union for the Conservation of Nature and Natural Resources
1110 Muges
Vand, Switzerland
Internet: http://w3.iprolink.ch/iucnlib

Rainforest Action Network
450 Sansome Street
Suite 700
San Francisco, CA 94111
Phone: 415-398-4404
Internet: http://www.ran.org

Rainforest Alliance
63 Bleeker St., 6th Floor
New York, NY 10012
Phone: 212-677-1900
Internet: http://www.rainforest-alliance.org

Sierra Club
85 2nd Street, 2nd Floor
San Francisco, CA 94105
Phone: 415-977-5500
Internet: http://www.sierraclub.org
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The Nature Conservancy
1815 North Lynn Street
Arlington, Virginia 22209
Phone: 703-841-5300
Internet: http://www.tnc.org

The Rainforest Foundation
270 Lafayette Street
Suite 1107
New York, NY 10012
Phone: 212-431-9098
Internet: http://www.euronet.nl/users/trp/index.htm

World Wildlife Fund
1250 24th Street, NW
Suite 400
Washington, D.C. 20037
Phone: 202-293-4800
Internet: http://www.wwf.org

World Rainforest Movement
87 Contonment Road
10250 Penang, Malaysia
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